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Performance and yield level of key asset classes as of 2026/1/30

Source: Bloomberg, as of 30 January 2026. See notes at the bottom for indices used. Past performance is not a reliable indicator of current or future results and should not be the sole factor of 
consideration when selecting a product or strategy. Indices are unmanaged and one cannot invest directly in an index.

January Market Highlights

FX Hedging: FX Forward Premium or Cost as of 2026/1/30
FX Forward Premium or Cost is associated mainly with short-term interest rate differential between domestic and 

foreign currency (& currency basis). This impact can be positive or negative depending on the currency pair. 
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Currency to Hedge (Forward tenors: 3-month and 12-month, annualized)

A monthly brief on Fixed Income markets, sector 
performance, bond ETF flows and product trends

iShares Fixed Income Product Strategy

Source: Bloomberg, as of 30 January 2026. Indices used: BBG Global Aggregate Index (USD, unhedged), BBG US Aggregate Index (USD), NOMURA BPI (JPY), BBG US Treasury Index (USD), 
BBG Agency MBS Index (USD), BBG China Treasury & Policy Bank Index (CNY), BBG US IG Corporate Index (USD), BBG US HY Corporate Index (USD), JP Morgan Asia Credit IG Index (USD), JP 
Morgan Asia Credit HY Index (USD), JP Morgan EMBI Global Diversified Index (USD), JP Morgan GBI-EM Index (USD, unhedged). Reference to the company name mentioned in this 
communications is merely for explaining the investment strategy, and should not be construed as investment advice or investment recommendation of those companies.
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Global rates opened 2026 on a steady footing, with the Fed keeping rates at 3.50%-3.75% as expected 

while maintaining a hawkish tilt amid still-sticky inflation. However, markets jolted late in the month 

after Trump nominated Warsh for Fed Chair, with yields grinding upwards alongside a dollar rally as 

expectations around future easing tightened. In Europe, the ECB held rates steady as inflation softened 

which reinforced its wait-and-see stance, while the BOE which kept rates at 3.75% in a narrow 5-4 vote. 

In Japan, the BOJ paused its ongoing rate hikes, though January was marked by rate volatility as long-

end JGBs sold off with yields reaching record highs following PM Takaichi’s expansionary fiscal stance.

Global 
Rates

Credit

Credit displayed notable resilience in January, shrugging off geopolitical headlines tied to Venezuela 

amidst a heavy issuance calendar. Spreads across regions continued their grind tighter, supported by 

robust demand-side technicals and elevated all-in yields. Asia HY was the outperformer, ending the 

month 43bps tighter, while Asia IG tightened by 4bps. In the US, spreads hovered near end-2025 levels, 

with IG spreads closing 5bps tighter, while HY spreads tightened by 1bp.

USD EUR USD EUR

JPY -3.04% -1.35% -2.62% -1.12%

KRW -1.24% +0.46% -1.07% +0.46%

AUD +0.23% +1.93% +0.71% +2.26%

CNY -1.65% +0.04% -1.94% -0.40%

SGD -2.48% -0.79% -2.22% -0.70%

3M 12M

Index YTD QTD MTD Jan-end ΔMTD ΔYTD Jan-end ΔMTD ΔYTD

Global Aggregate 0.94% 0.94% 0.94% 3.53% 0.01% 0.01%

US Aggregate 0.11% 0.11% 0.11% 4.36% 0.04% 0.04%

Japan FI, N-BPI -1.26% -1.26% -1.26% 2.07% 0.13% 0.13%

US Treasury -0.09% -0.09% -0.09% 3.97% 0.08% 0.08%

Agency MBS 0.41% 0.41% 0.41% 4.64% 0.01% 0.01%

China(CGB+PB) 0.36% 0.36% 0.36% 1.69% -0.04% -0.04%

US IG Corporates 0.18% 0.18% 0.18% 4.84% 0.03% 0.03% 73 -5 -5

US HY Corporates 0.51% 0.51% 0.51% 6.58% 0.05% 0.05% 265 -1 -1

Asia IG, JACI IG -0.07% -0.07% -0.07% 4.86% 0.09% 0.09% 98 -4 -4

Asia HY, JACI HY 2.24% 2.24% 2.24% 7.56% -0.51% -0.51% 369 -43 -43

EM HC, EMBI GD 0.68% 0.68% 0.68% 6.78% -0.02% -0.02% 245 -9 -9

EM LC, GBI-EM 2.18% 2.18% 2.18% 5.86% -0.01% -0.01% - - -

Credit 

(IG & HY)

Emerging 

Markets

Spread level (bps)

(credit only)
Yield levelTotal Return

Aggregate

Treasury &  

Agency
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Emerging Markets

Top/Bottom iShares Fixed Income ETF Sector Flows

Bottom 5 Exposures
MTD Flow

($M)
% of 
AUM

U.S Treasury – Lond Dur (3,072) -5%

Investment Grade – Broad (1,457) -1%

High Yield – Broad (1,084) -1%

Inflation Broad (197) -1%

Non U.S Sovereign – Long Dur (58) -1%

Bottom 5 Exposures Total (5868)

Top 5 Exposures
2025 Flow 

($M)
% of 
AUM

U.S. Treasury – Short Dur 46,397 30%

Multi Sector – Broad 31,829 14%

U.S Treasury – Inter Dur 16,035 19%

High Yield - Broad 15,264 18%

Investment Grade – Fixed Mat 8,539 24%

Top 5 Exposures Total 118,064

Bottom 5 Exposures
2025 Flow 

($M)
% of AUM

Multi Sector - ESG (155) -8%

Inflation – Broad (84) 0%

Covered - Intermediate (30) -6%

Emerging Markets – Short Term (28) -

Loans - Broad 3 5%

Bottom 5 Exposures Total (294)

Source: BlackRock, as of January 31 2026. Reference to $ refers to USD.
iShares and industry ETF flows encompass globally listed products. ‘Broad’ categories reference blended maturity products EM flows in the top tight chart are ex-China.
 

Top 5 Exposures
MTD Flow

($M)
% of 
AUM

Multi Sector – Broad 5,536 2%

U.S Treasury – Short Dur 2,314 1%

U.S Treasury – Inter Dur 2,132 2%

Emerging Markets – Broad 2,110 4%

U.S Treasury - Broad 1,813 4%

Top 5 Exposures Total 13,906

FOR PROFESSIONAL, ACCREDITED, INSTITUTIONAL AND WHOLESALE INVESTORS USE 

ONLY – NOT FOR PUBLIC DISTRIBUTION (PLEASE READ IMPORTANT DISCLOSURES)

2026 January iShares Status Flow

1. iShares fixed income ETFs kicked off 2026 on a strong note, gathering +$17B - the strongest 

January since 2023. Inflows were led by Multisector (+$6B) and U.S. Treasuries (+$3.6B), with EM 

(+$2.1B) and Non-U.S. Sovereigns (+$1.5B) also contributing meaningfully.

2. U.S Treasuries remained a key flow driver, with demand concentrated at the short and 

intermediate segments of the curve. The 0–3M and 7–10Y buckets each attracted over +$1.4B, 

while the flagship broad duration exposure added +$1.9B. Outflows persisted at the long end, 

primarily driven by the 20Y+ trading vehicle.

3. EM exposures logged their strongest month since June 2025, with inflows concentrated in 

local currency exposures while hard currency remained positive (+$365M). Flagship local 

currency exposures stood out with +$1.1B, while single country government bond exposures were 

also positive including Brazil (+$205M), China (+$159M) and India (+$28M).

4. Multisector exposures were the largest flow gatherer in January, logging the strongest month 

since September 2024. Flows were led by the flagship Core U.S. Aggregate exposure, which 

gathered +$2.4B during the month. Non-U.S. Sovereign continued to gain traction with the 

flagship global government bond exposure attracting +$1.3B, underscoring sustained investor 

demand for global diversification in portfolios.

5. Active and outcome-oriented strategies logged a robust month in flows, adding +$4.4B. 

iBonds target maturity ETFs added (+$2B) while the flexible income strategy added  (+$1.2B).

MKTG0226-5211001-EXP0227-2/6
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Riding the Income in fixed income

To find out more about building a Bond ETF Income Portfolio, contact your iShares representative.

FOR PROFESSIONAL, ACCREDITED, INSTITUTIONAL AND WHOLESALE INVESTORS USE 

ONLY – NOT FOR PUBLIC DISTRIBUTION (PLEASE READ IMPORTANT DISCLOSURES)

Central bank policy shifts since 2022 ushered in a golden age of fixed income where bonds have become a 

primary engine for yield after an extended period of low interest rates. Currently, over 60% of fixed income 

assets still yield over 4%. As elevated yields continue to make income a key driver of steady returns, investors 

can benefit from using all the tools at their disposal to find diversified and differentiated sources of income.

Today, bond ETFs offer access to an array of fixed income global opportunities, allowing investors to make use 

of the full scope of the investing universe to construct a modern portfolio geared towards stable income 

generation. The outcome? A 6% bond income portfolio made entirely from bond ETFs, without needing to 

overextend on risk, both in terms of going down the credit quality spectrum or taking on too much duration.

Source: BlackRock, as of 31 January 2026. * Risk represents ex-ante risk analysis, based on 252 daily observations with 40-day half life. Returns are based on a composite of daily index 
returns based on static weights as per the 6% Yield table above, with returns for each exposure on an unhedged/USD-hedged basis respectively.

The 6% Yield Portfolio

Attractive yield with lower risk and duration than 
core fixed income exposures…

… and stable returns in an environment where 
fixed income returns have been rooted in income

Source: BlackRock, Bloomberg, as of 16 January 2026. Risk represents ex-ante risk analysis, based on 252 daily observations with 40-day half life.* Yields are USD-hedged. ** Net of US 
withholding tax after reclaiming Qualified Interest Income (QII), based on respective QII percentages.

Exposure Index Yield Duration Weight

Treasuries
UST 3-7Y 3.82% 4.3Y 4%

EUR Govies 4.58% * 6.9Y 4%

Securitised US MBS 4.70% 5.3Y 12%

Investment 
Grade

USD IG 4.82% 6.3Y 5%

EUR IG 4.85% * 4.4Y 5%

High Yield

US HY 6.85% 2.8Y 10%

EUR HY 6.45% * 2.9Y 10%

Asia HY 6.68% 2.6Y 5%

Loans US Bank Loans 6.02% ** 0.3Y 5%

AAA CLOs
US CLOs 4.95% 0.2Y 10%

EUR CLOs 4.87% * 0.2Y 5%

AT1 Global AT1s 6.45% * 3.6Y 5%

BuyWrites HY BuyWrite 8.40% ** 2.7Y 5%

Emerging 
Markets

EMD HC 5.97% 6.7Y 3%

EMD Corp 5.61% 4.3Y 3%

EMD LC 6.18% 5.4Y 5%

India Govies 6.64% 6.0Y 2%

Brazil Govies 13.44% 2.3Y 2%

Yield Duration Risk Rating

6.0 % 3.5 Year 226 bps A-

1 Utilising the global opportunity set

Leveling up with the securitized stack

Expanding the income toolkit

2

3

Portfolio
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Diverging central bank policy and geopolitical 

uncertainty means investors can benefit from a 

diversified global allocation – from core USD 

exposures, to EUR exposures hedged to USD for a 

yield pickup, to Emerging Markets Debt which offer 

diversification benefits and more attractive income

What’s the secret sauce?

Innovative products such as BuyWrite covered call 

ETFs convert upside potential to coupon income, 

and can offer enhanced income potential through 2 

distinct sources of income – the underlying ETF 

distributions and income from option premiums

Bond ETFs now offer targeted exposure to plus 

sectors including AAA CLOs and Global AT1s 

through an actively managed approach, which offer 

attractive yields, as well as stronger relative value 

and uncorrelated sources of returns compared to 

traditional fixed income

* Bubble size scaled by risk

1Y Vol
Port US Agg Global Agg USD IG USD HY

1.30% 2.89% 1.94% 2.76% 2.67%
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Source: BlackRock, “Innovation meets opportunity”, as of April 2025. There is no guarantee that any forecasts made will come to pass. All $ in USD unless otherwise stated.

Innovation Meets Opportunity
How years of constant fixed income ETF innovation are empowering investors to 
navigate today’s markets and build portfolios for the new era

Index Your Bonds with Asia Credit

Asia bond markets definitely have a part to play in the next leg of 

growth in index and ETF adoption. As investors continue to move 

beyond the “active versus passive” debate, constant product 

innovation will offer increasingly precise sources of potential 

returns, and help lead more investors to embrace bond index 

building blocks alongside high conviction active strategies in 

pursuit of optimal portfolio outcomes.

In this Asia-focused “Index Your Bonds” paper, we spotlight 

iShares Asia Credit exposures, provide insights on how they are 

managed in practice, and discuss how innovations such as ESG 

integration will make indexing an integral part of investing in Asia 

fixed income.

FOR PROFESSIONAL, ACCREDITED, INSTITUTIONAL AND WHOLESALE INVESTORS USE 
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Last year, our whitepaper “No Time to Yield” discussed 
why investors may want to consider getting cash off the 
sidelines and employing bond ETFs in the new market 
regime.

In our latest paper “Innovation Meets Opportunity”, we 
highlight how accelerating bond ETF innovation has 
equipped investors with a robust ETF toolkit that simply 
did not exist the last time yields were at these levels, and 
how investors can use bond ETFs to navigate both 
today’s and tomorrow’s market environments.

Did you know?

• Client demand for fixed income ETFs is driving significant asset growth with record flows 
in 2024 and on track to reach $6 trillion in assets under management (AUM) by 2030, if not 
sooner. Globally, bond ETFs experienced the highest organic asset growth (20%) of any other 
asset class or investment vehicle last year. And so far in 2025, client adoption continues to 
accelerate, with assets up 22% on an annualized basis. 

• The flywheel of bond ETF innovation is powering this growth, helping more investors to 
access exposures and outcomes that were previously difficult to access. Last year a record 
420 bond ETFs were launched, enabling investors to tailor their fixed income investments in 
ways previously unthinkable. 

• The ever-increasing toolkit allows investors to take advantage of a generational 
opportunity in fixed income. Yields are higher than they have been in 20 years. Globally, some 
80% of fixed income assets now yield over 4% and we believe they’ll remain elevated for the 
foreseeable future. 

• iShares has been spearheading innovation in bond ETFs for over two decades. Our diverse 
and evolving product set supports clients globally to navigate across market environments, 
with more modern, precise ways to reach nearly every part of the fixed income market. As the 
experts in portfolio construction with a strong heritage in risk management, we understand the 
tools and exposures that investors require to thrive in a changing world.

2

3

1

4

DOWNLOAD THE PAPER >

DOWNLOAD THE PAPER >

MKTG0226-5211001-EXP0227-4/6

https://images.marketing.blackrock.com/Web/BlackRock/%7Ba149edc0-e71f-410a-9852-7f716e7c270e%7D_Asia_Credit_-_Index_Your_Bonds_-_v2023_for_AI_updated_STAMPED.pdf?cid=emc:iSharesAxj2023IndexYourBondWP:INST:ENL:AxJ:APAC&elq_mid=80047&elq_cid=6203589&elq_cmp=30351
https://images.marketing.blackrock.com/Web/BlackRock/%7Ba149edc0-e71f-410a-9852-7f716e7c270e%7D_Asia_Credit_-_Index_Your_Bonds_-_v2023_for_AI_updated_STAMPED.pdf?cid=emc:iSharesAxj2023IndexYourBondWP:INST:ENL:AxJ:APAC&elq_mid=80047&elq_cid=6203589&elq_cmp=30351
https://images.marketing.blackrock.com/Web/BlackRock/%7Ba149edc0-e71f-410a-9852-7f716e7c270e%7D_Asia_Credit_-_Index_Your_Bonds_-_v2023_for_AI_updated_STAMPED.pdf?cid=emc:iSharesAxj2023IndexYourBondWP:INST:ENL:AxJ:APAC&elq_mid=80047&elq_cid=6203589&elq_cmp=30351
https://images.marketing.blackrock.com/Web/BlackRock/%7Ba149edc0-e71f-410a-9852-7f716e7c270e%7D_Asia_Credit_-_Index_Your_Bonds_-_v2023_for_AI_updated_STAMPED.pdf?cid=emc:iSharesAxj2023IndexYourBondWP:INST:ENL:AxJ:APAC&elq_mid=80047&elq_cid=6203589&elq_cmp=30351
https://images.marketing.blackrock.com/Web/BlackRock/%7Ba149edc0-e71f-410a-9852-7f716e7c270e%7D_Asia_Credit_-_Index_Your_Bonds_-_v2023_for_AI_updated_STAMPED.pdf?cid=emc:iSharesAxj2023IndexYourBondWP:INST:ENL:AxJ:APAC&elq_mid=80047&elq_cid=6203589&elq_cmp=30351
https://www.blackrock.com/institutions/en-axj/literature/whitepaper/innovation-meets-opportunity-2025-apac.pdf
https://www.blackrock.com/institutions/en-axj/literature/whitepaper/innovation-meets-opportunity-2025-apac.pdf
https://www.blackrock.com/institutions/en-axj/literature/whitepaper/innovation-meets-opportunity-2025-apac.pdf
https://www.blackrock.com/institutions/en-axj/literature/whitepaper/innovation-meets-opportunity-2025-apac.pdf
https://www.blackrock.com/institutions/en-axj/literature/whitepaper/innovation-meets-opportunity-2025-apac.pdf


Guides
Go to View and check the “Guides” box to see page 
margins and columns. This feature will help align 
items on the page.  

Text
Adjust text sizes as needed. Bigger is better. Use 
only BLACK or WHITE text. Use font size and/or 
the Extrabold, Bold, or Body font weights instead of 
color to differentiate.

Layouts
Go to the Layout menu on the Home tab to access 
additional page layout options. 

Charts
Axis lines: .25pt black

Base line: 1pt black

Trend lines: 2pt (minimum) thick lines are standard

Bars: thick bars are standard style

Text labels: 8pt BLK Fort (minimum) 

Tables
Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Use black for header row shading as the standard 
choice. Highlight key information by shading rows 
and columns with colors from the primary brand 
color palette. 

When your document lacks any color in the overall 
design, a good option is to add color by shading the 
header bar of tables with colors from the primary 
brand palette. Use this approach sparingly. 

Compliance
If you are creating financial promotions/marketing 
materials, please consult the applicable content 
policies and approval procedures in your region.

Helpful hints

Important information

This material is provided for educational purposes only and is not intended to be relied upon as a forecast, research or investment 
advice, and is not a recommendation, offer or solicitation to buy or sell any securities or iShares Funds, nor to adopt any investment 
strategy. The opinions expressed are subject to change. References to specific securities, asset classes and financial markets are for 
illustrative purposes only and are not intended to be and should not be interpreted as recommendations. There are risks associated 
with investing, including loss of principal. The value of investments involving exposure to foreign currencies can be affected by 
exchange rate movements. Reliance upon information in this material is at the sole risk and discretion of the reader. The material was 
prepared without regard to specific objectives, financial situation or needs of any investor. You are reminded to refer to the relevant 
prospectus for specific risk considerations which are available from BlackRock or the iShares websites.

This material may contain “forward-looking” information that is not purely historical in nature. Such information may include, among 
other things, projections, forecasts, and estimates of yields or returns. No representation is made that any performance presented will 
be achieved by any BlackRock or iShares Funds, or that every assumption made in achieving, calculating or presenting either the 
forward-looking information or any historical performance information herein has been considered or stated in preparing this 
material. Any changes to assumptions that may have been made in preparing this material could have a material impact on the 
investment returns that are presented herein. Past performance is not a reliable indicator of current or future results and should not 
be the sole factor of consideration when selecting a product or strategy.

The information and opinions contained in this material are derived from proprietary and nonproprietary sources deemed by 
BlackRock to be reliable, are not necessarily all-inclusive and are not guaranteed as to accuracy.

In Hong Kong, this material is issued by BlackRock Asset Management North Asia Limited and has not been reviewed by the 
Securities and Futures Commission of Hong Kong. This material is for distribution to "Professional Investors" (as defined in the 
Securities and Futures Ordinance (Cap.571 of the laws of Hong Kong) and any rules made under that ordinance) and should not be 
relied upon by any other persons or redistributed to retail clients in Hong Kong.

In Singapore, this is issued by BlackRock (Singapore) Limited (Co. registration no. 200010143N) for use only with accredited and 
institutional investors as defined in Section 4A of the Securities and Futures Act, Chapter 289 of Singapore. This advertisement or 
publication has not been reviewed by the Monetary Authority of Singapore.

In South Korea, this information is issued by BlackRock Investment (Korea) Limited. This material is for distribution to the Qualified 
Professional Investors (as defined in the Financial Investment Services and Capital Market Act and its sub-regulations) and for 
information or educational purposes only, and does not constitute investment advice or an offer or solicitation to purchase or sells in 
any securities or any investment strategies.

In Taiwan, independently operated by BlackRock Investment Management (Taiwan) Limited. Address: 28F., No. 100, Songren Rd., 
Xinyi Dist., Taipei City 110, Taiwan. Tel: (02)23261600.

In Australia & New Zealand, issued by BlackRock Investment Management (Australia) Limited ABN 13 006 165 975, AFSL 230 523 
(BIMAL) for the exclusive use of the recipient, which warrants by receipt of this material that it is a wholesale client as defined under 
the Australian Corporations Act 2001 (Cth) and the New Zealand Financial Advisers Act 2008 respectively.

BIMAL is not licensed by a New Zealand regulator to provide ‘Financial Advice Service’, 'Investment manager under an FMC offer' or 
‘Keeping, investing, administering, or managing money, securities, or investment portfolios on behalf of other persons’. BIMAL’s 
registration on the New Zealand register of financial service providers does not mean that BIMAL is subject to active regulation or 
oversight by a New Zealand regulator.

This material provides general advice only and does not take into account your individual objectives, financial situation, needs or 
circumstances. Before making any investment decision, you should therefore assess whether the material is appropriate for you and 
obtain financial advice tailored to you having regard to your individual objectives, financial situation, needs and circumstances. Refer 
to BIMAL’s Financial Services Guide on its website for more information. This material is not a financial product recommendation or 
an offer or solicitation with respect to the purchase or sale of any financial product in any jurisdiction.

Information provided is for illustrative and informational purposes and is subject to change. It has not been approved by any 
regulator.

This material is not intended for distribution to, or use by, any person or entity in any jurisdiction or country where such distribution or 
use would be contrary to local law or regulation. BIMAL is a part of the global BlackRock Group which comprises of financial product 
issuers and investment managers around the world. BIMAL is the issuer of financial products and acts as an investment manager in 
Australia. BIMAL does not offer financial products to persons in New Zealand who are retail investors (as that term is defined in the 
Financial Markets Conduct Act 2013 (FMCA)). This material does not constitute or relate to such an offer. To the extent that this 
material does constitute or relate to such an offer of financial products, the offer is only made to, and capable of acceptance by, 
persons in New Zealand who are wholesale investors (as that term is defined in the FMCA).

BIMAL, its officers, employees and agents believe that the information in this material and the sources on which it is based (which 
may be sourced from third parties) are correct as at the date of publication. While every care has been taken in the preparation of this 
material, no warranty of accuracy or reliability is given and no responsibility for the information is accepted by BIMAL, its officers, 
employees or agents. Except where contrary to law, BIMAL excludes all liability for this information.

Any investment is subject to investment risk, including delays on the payment of withdrawal proceeds and the loss of income or the 
principal invested. While any forecasts, estimates and opinions in this material are made on a reasonable basis, actual future results 
and operations may differ materially from the forecasts, estimates and opinions set out in this material. No guarantee as to the 
repayment of capital or the performance of any product or rate of return referred to in this material is made by BIMAL or any entity in 
the BlackRock group of companies.

No part of this material may be reproduced or distributed in any manner without the prior written permission of BIMAL.
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Guides
Go to View and check the “Guides” box to see page 
margins and columns. This feature will help align 
items on the page.  

Text
Adjust text sizes as needed. Bigger is better. Use 
only BLACK or WHITE text. Use font size and/or 
the Extrabold, Bold, or Body font weights instead of 
color to differentiate.

Layouts
Go to the Layout menu on the Home tab to access 
additional page layout options. 

Charts
Axis lines: .25pt black

Base line: 1pt black

Trend lines: 2pt (minimum) thick lines are standard

Bars: thick bars are standard style

Text labels: 8pt BLK Fort (minimum) 

Tables
Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Use black for header row shading as the standard 
choice. Highlight key information by shading rows 
and columns with colors from the primary brand 
color palette. 

When your document lacks any color in the overall 
design, a good option is to add color by shading the 
header bar of tables with colors from the primary 
brand palette. Use this approach sparingly. 

Compliance
If you are creating financial promotions/marketing 
materials, please consult the applicable content 
policies and approval procedures in your region.

Helpful hints

In China, this material may not be distributed to individuals resident in the People's Republic of China ("PRC", for such purposes, not 
applicable to Hong Kong, Macau and Taiwan) or entities registered in the PRC unless such parties have received all the required PRC 
government approvals to participate in any investment or receive any investment advisory or investment management services.

For Other Countries in APAC: this material is provided for your informational purposes only and must not be distributed to any other 
persons or redistributed. This material is issued for Institutional Investors only (or professional/sophisticated/qualified investors as 
such term may apply in local jurisdictions) and does not constitute investment advice or an offer or solicitation to purchase or sell in 
any securities, BlackRock funds or any investment strategy nor shall any securities be offered or sold to any person in any jurisdiction 
in which an offer, solicitation, purchase or sale would be unlawful under the securities laws of such jurisdiction.

The information provided here is not intended to constitute financial, tax, legal or accounting advice. You should consult your own 
advisers on such matters. BlackRock does not guarantee the suitability or potential value of any particular investment. Investment 
involves risk including possible loss of principal. International investing involves risks, including risks related to foreign currency, 
limited liquidity, less government regulation, and the possibility of substantial volatility due to adverse political, economic or other 
developments. These risks are often heightened for investments in emerging/developing markets or smaller capital markets.

The information provided here is not intended to constitute financial, tax, legal or accounting advice. You should consult your own 
advisers on such matters.

THIS MATERIAL IS HIGHLY CONFIDENTIAL AND IS NOT TO BE REPRODUCED OR DISTRIBUTED TO PERSONS OTHER THAN THE 
RECIPIENT. 

©2026 BlackRock, Inc. or its affiliates. All Rights Reserved. iShares® and BlackRock® are registered trademarks of BlackRock, Inc. or its 
affiliates in the United States and elsewhere. All other trademarks, servicemarks or registered trademarks are the property of their 
respective owners.
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